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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage 
to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices 
referring only to property damage have no safety alert symbol. These notices shown below are graded according to 
the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance 
are required to ensure that the products operate safely and without any problems. The permissible ambient 
conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may 
be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in this 
publication is reviewed regularly and any necessary corrections are included in subsequent editions.

Siemens AG
Digital Industries
Postfach 48 48
90026 NÜRNBERG
GERMANY
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Validity 1
Validity

This update is valid for the following products:
• WinCC Unified V17
• WinCC Unified Runtime V17

Note
If you modify your system after installing the update with the product DVD, you will have to 
perform the update again.
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Important notes 2
This page contains important information about product properties

Device versions with V17 Update 1
The new device version 17.0.0.1 was introduced for Unified PC and Unified Comfort Panels in 
order to be able to use the new functions which have been introduced with V17 Update 1. Please 
note the following:
• If you open a project on a computer on which TIA Portal V17 is installed without an update, 

you cannot edit the devices contained there with device version 17.0.0.1.
• If you switch from a device version 17.0.0.1 to a previous device version, you can no longer 

use new functions such as switching the visibility of layers or the "Authorization" interface 
property for faceplates.

• The functions are also supported by higher device versions.
Unified PC
• Install Update 1 for WinCC Unified Runtime on the target device before loading a device with 

device version 17.0.0.1.

Images for Unified Comfort Panel
• Images can be downloaded from the Industry Online Support.
• Images are released independent of WinCC (TIA Portal). 
• Use ProSave to import an image version that does not correspond to the configured device 

version onto a panel.
• If a new image only contains improvements for the runtime of the device, this version is not 

shown in the engineering system. In this case, use the most recent device version displayed 
in the engineering system.

• If the image 17.0.0.0 is installed on the device, install image download version V17.0 Upd.1 
or higher before you load a device with the configured device version 17.0.0.1. When loading 
this device, activate the setting "Keep aspect ratio" in the "Load preview" dialog so that the 
new image version is transferred to the Panel. Alternatively, use ProSave.

• If you load a device with the configured device version 17.0.0.0, it is not absolutely necessary 
to update the image on the panel. If you load a device with the configured device version 
17.0.0.0 onto a Panel with a higher image version, warnings are issued regarding the 
different versions. You can ignore them.

Readme WinCC Unified Runtime
Readme, 04/2022, Online documentation 7



Character sets after Windows 10 update
Since Windows 10 Update Version 1809, Windows allows the installation of character sets either 
with administrator rights for each user (command "Install for all users" in the shortcut menu) or 
for specific users. In order to use WinCC character sets without restrictions and load them onto 
an HMI device, the character sets must always be installed with administrator rights.
Note that the "Install" button in the view of a character set only initiates a user-specific 
installation.

"Allow operator control" property for operable screen objects
If you disable the option of operation in runtime for objects of the "Elements" group using the 
"Allow operator control" property, the object is grayed out in the engineering system and in 
runtime. For objects of the "Controls" group, the "Allow operator control" property affects 
operable areas, e.g. toolbar buttons.
The objects are displayed in engineering system as well as in runtime. 

Number of connections used in the connection overview
An S7-1200 PLC can be connected to up to 6 HMI Unified devices via integrated connections. 
Under certain circumstances, the number of connections used is not correctly displayed in the 
connection information of the device view for HMI communication. The connections can still be 
used without restrictions.

Key length of certificates for audit
Audit does not support certificates with a key length greater than 2048.

Supported trend modes
The trend control does not support the "Bar" trend mode. If you select the "Bar" trend mode in 
engineering, the "Values" trend mode is used in runtime.

Runtime language
When using central user management, runtime is displayed in the language you have selected 
in the "User login" during login.
If this language is not available for the current project or if the language setting was not set in 
the central user management, the language that was given the lowest number in the runtime 
settings during engineering is displayed.
If you do not select a language in the "User login" dialog, runtime is displayed in the language 
that is set for the browser.

Important notes
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Login not possible
If it is not possible to log on to Runtime or to Simulation and you receive a "Wrong name or 
password" message, check to see if a role is assigned to the "Anonymous" user. If necessary, 
remove the role assignment and reload the project. When loading, make sure that the user 
administration data is reset to the start values.

PDF creation for reports via MS Excel
For PDF creation of reports using MS Excel, proceed as follows:
1. Installing V17 Update 4 on your HMI device.
2. Start WinCC Unified Configuration on your device.
3. In the "Reporting" step, select MS Excel as the application for PDF creation. Note: If this setting 

was made earlier, select Excel again. Applying the existing configuration is not sufficient.
4. Set the user name and password of the Windows user that will be used for PDF creation.

Select a new user name or the user name of an existing user.
5. Apply the configuration.

Reports on Unified Comfort Panels
A memory card must be inserted to use reports on a Unified Comfort Panel.

Renaming worksheets and segments in report templates
When you add a segment to a report template in the Excel Add-In, a table is created in Excel. The 
Add-In addresses the table by the name of the worksheet and segment.
Do not rename worksheets after adding segments.
Do not change the table name of a segment using "Table Name" property of Excel. Edit the 
segment in the Add-In and rename it there.

"Partly running" status
If it is not possible to start the simulation or the Unified Runtime, open the Runtime Manager. If 
the status of the project is displayed as "partly running", check whether 
• The user currently logged on in Runtime has sufficient rights. If the user is entered into the 

following Windows user groups:
PLCSimUsers
RTIL Tracing Users
Siemens TIA Engineer
SIMATIC HMI
SIMATIC HMI VIEWER

• The computer name is not longer than 15 characters.
• "OPC UA" is activated in the Runtime settings and a certificate is available.
• "Runtime Collaboration" is enabled in the Runtime settings of a Unified Panel and a 

certificate is available.

Important notes
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No special characters in the TIA Portal installation path
There can be no special characters in the TIA Portal installation path. Special characters in the 
installation path cause the TIA Portal to crash when you add a screen for an HMI device.

SVG graphics in faceplates with "Fit to object size" setting
SVG graphics for which the "Scale to object size" property in engineering in faceplates is set to 
"Fit to object size" are not displayed correctly in runtime in Chrome.
Convert such a graphic into a bitmap and use it in engineering. Or choose another browser as 
web client for runtime, e.g. Firefox.

Info text in the alarm log
Info text is displayed in the current alarms and in the alarm buffer. However, it is not logged and 
displayed in the alarm log of a Panel.

Important notes
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Unified Engineering 3
3.1 Improvements in Update 5

This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among other things, on the feedback 
received.

System diagnostics
The "System initialized..." system event now also shows the IP address of the PLC from whose 
buffer this event was read.

Alarms
When exporting alarms, alarms with a multiline alarm text are also exported correctly. The 
multiline alarm text is exported as single-line text.

Scripting
The ".toLocaleTimeString" JavaScript method now takes daylight saving time into account.

Simulation
Simulation of projects containing faceplates with tags has been stabilized.

Reporting
• When report templates contain Excel charts that display or process data source element cells, 

the reports are now generated correctly.
• When generating reports with LibreOffice, the output of single-value segments that contain 

string variables has been improved.
• In a report template, if you assign a custom format to a cell of a segment that contains special 

characters, the cell is displayed correctly in the generated report.

VoT: Number formats
The display of number formats has been improved.

Readme WinCC Unified Runtime
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3.2 Improvements in Update 4
No new device versions are made available in the Engineering System with this update. This 
update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based, among other things, on the feedback 
received.

Alphabetical sorting for graphic types
The graphic types are sorted in alphabetical order in WinCC Unified in the project library and in 
the selection dialog for graphic types under "Properties > General > Graphic" in the "Static value" 
column.

"Screens" editor
If the "Same Width and Height" function is applied to the "Line" object, all relevant properties are 
transferred correctly.

Link to the referenced object
The resource list can be opened for editing via a link at the dynamization point.

Overlapping ranges in the dynamization of tags
Dynamization of an object property with tags of "Range" type can overlap the values in the 
individual ranges. 
Cells where range overlaps occur are highlighted in color. The overlaps are reported as a warning 
when compiling the project. Downloading to the device is possible. The first highlighted value 
is always used in runtime. 

Unified Engineering
3.2 Improvements in Update 4
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"Find and replace" palette in the "Tasks" task card
The "Tasks" task card contains the "Find and replace" palette for searching within an open editor. 
The palette includes all options for an efficient search. The individual search hits or all found texts 
can be replaced.

Default sorting of alarm view
The order of column sorting has been improved.
• If the "Priority" column is defined in the alarm view, sorting is based on alarm priority. As a 

result, in a single-line alarm view, only the top-priority alarm appears in the alarm window. 
A lower-priority alarm will not be displayed, even if it is more recent. The alarms are displayed 
in chronological order.

• If one of the following columns in the alarm view is configured, sorting on a Unified Comfort 
Panel is according to the specified order.
1. Priority
2. Modification time
3. Raise time
4. Alarm state

On a Unified Comfort Panel, sorting "descending" can also be performed in addition to 
"ascending" with this update.

Faceplates
To use graphics from the project library in faceplates, copy the graphic and paste it into the 
"Master copies" folder.
In a faceplate type, the entries in the Tags interface and the Properties interface can be selected 
individually or copied as an entire interface and pasted in the same place or in another faceplate 
type. To copy and paste, use the shortcut menu or the <Ctrl> + <C> and <Ctrl> + <V> key 
combinations.
To improve performance during the engineering process when using a large number of 
faceplates, activate the "Simplified display of faceplates on Unified devices" option under 
"Settings > Visualization > Unified Faceplate". The faceplates are displayed in a simplified way 

Unified Engineering
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when this option is activated in the engineering system. This change has no effect on the display 
in runtime. In runtime, faceplates are displayed in unrestricted quality.

Scripting
After a project is upgraded, the "Screen name" parameter appears in system functions. 
Global search in scripts: To find strings that are used in scripts, use the global search in the 
project. You access global search under "Edit > Search project" or by using the shortcut <Ctrl> + 
<F>. The search will also find system functions used in the project.
Even if an HMI device has been configured in a folder, the configured screens can be accessed via 
system functions, for example, when using the "ChangeScreen" system function.

Display of screen objects in the simulation
When using styles, frames are displayed identically in the simulation and on a Unified Panel.

Parallel communication with multiple PLCs via PROFINET interfaces
Parallel communication with several PLCs via the PROFINET interfaces X1 and X2 is possible.

View of Things
If a PLC is copied with a VoT application, the PLC can also be loaded after deleting the VoT 
application.
If the name of a member of a PLC user data type is changed and the interface in the PLC data type 
is updated, the referenced HMI tags are also updated.

3.3 Improvements in Update 3 

Contents
This update does not contain any improvements or changes relevant to WinCC Unified.

3.4 Improvements in Update 2
No new device versions are made available in the Engineering System with this update. This 
update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based, among other things, on the feedback 
received.

Unified Engineering
3.4 Improvements in Update 2
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Unified Collaboration
The "Parameter set control" and "Reports" screen objects can be used in screens that are 
displayed via Unified Collaboration in another runtime.

3.5 Improvements in Update 1
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

WinCC Unified Runtime for SIMATIC Panel PC
The following SIMATIC Panel PCs support WinCC Unified Runtime:
• IPC227G
• IPC277D
• IPC277E
• IPC277G
• IPC477E
• IPC 677E
• ITP 1000
After creating the device, you can insert a "SIMATIC WinCC Unified PC" into the device in the 
"Devices & Networks" device view. The default size for screens is automatically adapted to the 
device.

Unified Collaboration
Unified Collaboration supports alarms. 

Note
For alarms of a remote HMI device to be displayed in the alarm control, the HMI device must 
participate in Unified Collaboration.

When using alarm controls in connection with Unified Collaboration, note the following:
• For an alarm view, the "System" property can be used to configure which HMI devices are 

taken into consideration in the alarm control.
• At least one HMI device must be selected.

Display of local alarms is the default.

Unified Engineering
3.5 Improvements in Update 1
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Visibility of layers in runtime
Unified Runtime supports switching the visibility of layers using JScript functions.
1. In the engineering system, place the objects of a screen in the "Layout" task card on different 

layers.
2. Program a JScript function to change the visibility of, for example, "Layer_1" in the current 

screen.
Screen.Layers ("Layer_0").Visible = false;

3. Configure this function, e.g. on an event of a button.
If the event occurs in runtime, all objects placed on this layer become invisible.
To make a layer visible in the current screen, use: Screen.Layers("Layer_0").Visible = true;

Improvements in the screen editor
• The display of the objects in the "Toolbox" task card can be switched between an symbol view 

and a list view. In the symbol view you can switch the labeling of the objects on or off in the 
shortcut menu.

• To improve the visibility of the "Touch area" object in the engineering system, it is shown as 
a dotted area. This change has no effect on the display in runtime.

• If you have selected several objects, they are highlighted with a frame, the color of which 
depends on the background color of the screen.

• If you change the size of an object with the mouse while pressing the <SHIFT> key, the size 
can only be changed according to the aspect ratio.

• If you move a selected object with <SHIFT> and arrow key, the increment is based on the 
settings configured for the grid under "Options > Settings > Visualization > Screens > Grid".

• If you have selected several objects and change a property, this change is applied to all 
selected objects that have this property.

• If you have selected several objects and dynamize a property, for example via a script, this 
dynamization is applied to all selected objects. 

• In the "Screens" editor, the background color of the work area that lies outside the visible 
screen has been changed in order to better delimit the area of the visible screen.

Multiple line text for screen objects
The line break is entered using the <SHIFT + ENTER> key combination.
For the following screen objects, the specification for the "General > Text" property can be 
entered as multiple line text in the Inspector window under "Properties > Properties":
• Text box
• Button
• Switch

Unified Engineering
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For the following objects, the specification can be made under "General > Title > Text". A multiple 
line text can never contain more than two lines.
• Bar
• Slider
For the following objects, the specification can be made under "General > Selection items > [x] 
Selection item > Text". A multiple line text can contain more than two lines if the "Format > Item 
height" property is adjusted accordingly.
• Check box
• Radio button
• List box
Multiple line texts with a maximum of two lines can be used in the text lists for symbolic IO 
fields. 
You can also enter multiline text in the Inspector window under "Properties > Texts" and for text 
box and button by entering text directly. The line break is entered using the <SHIFT + ENTER> key 
combination.

Dynamization of a property
Groups containing a dynamized property are shown in dark blue font.
Dynamized properties are shown in dark blue font and in bold in the Inspector window.

Unified Engineering
3.5 Improvements in Update 1
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Improved usability for configuring object properties
When screen objects are configured, advanced options are available for transferring the values 
of properties of an object collection. Examples of object collections are:
• The points of a polygon
• The points of a polyline
• The entries of a check box
• The entries of a radio button
• The columns of an alarm control
• The trend areas of a trend control
• The icons of a toolbar of a screen object

Unified Engineering
3.5 Improvements in Update 1
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To automatically fill in the values of properties for objects, follow these steps:
1. Select the collection according to the object:

– For polygons and polylines, click "Properties > Properties > Size and position > Points".
– For the elements, e.g. check box, click "Properties > Properties> General > Selection 

entries".
– With the controls, e.g. alarm control, click "Properties > Properties 

> Miscellaneous > Alarm control > Columns".
– For the controls with a toolbar, click "Properties > Miscellaneous> Status bar > Elements".

2. Select one or more contiguous cells in the collection in the right part of the Inspector window.
3. Drag the blue border around this cell up or down. The values are transferred to the 

destination cells.

Tips for effective procedure

With autofill, you can also create new points for polygons and polylines. If you select a cell in the "X coordinate" or "Y coordinate" 
columns and drag the blue border up or down, the value is transferred into the destination cells. If you select multiple cells and 
there is a logical relationship between the values, the values of the destination cells are adapted according to the logical 
relationship.

Improved usability when dynamizing properties with tags
When configuring the dynamization of tags, autofill can also be applied to the Condition column. 
If you select a cell and drag the blue border up or down, the value is transferred into the 
destination cells. If you select multiple cells and there is a logical relationship between the 
values, the values of the destination cells are adapted according to the logical relationship.

0 - 4 Extend by 3 cells down 0 - 4
5 - 9 5 - 9
 10 - 14
 15 - 19
 20 - 24

Unified Engineering
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Direct text entry in the text box and button
You can change the label of the text box and button objects directly via the keyboard when the 
object is selected and in input mode (double-click). Special consideration should be given to the 
following: 
• Diacritics, such as ä ê ñ, can only be entered if the keyboard layout provides a key for this 

character. Key sequences such as <`a> for à, are not recognized.
• It is not possible to enter Unicode characters using Alt codes.
• Asian language characters cannot be entered using an Input Method Editor (IME).
If you need such characters in the label, you have the following options:
• Use a keyboard layout on which this character is present as a key.
• Copy the character or full label from any source. Paste the text into the selected object.
• Edit the label in the Inspector window under "Properties > Properties > General > Text".
Direct text entry also supports multiline text. The line break is entered using the <SHIFT + 
ENTER> key combination.

Rewiring tags in screens
You can change the references of tags in the properties of screen objects using the "Change 
object references" dialog. This function lets you to replace a large number of tags in various 
screen objects. You open the "Change object references" dialog using the command in the 
shortcut menu for single or multiple screen objects or a screen.
1. Select an object in the screen that contains a tag that you want to change.
2. Select the "Change object references" command in the shortcut menu or in the "Edit" menu.

The "Change object references" dialog opens. You can see the selected screen objects and the 
tags used in the "Object" column. 

3. Enter the name or part of the name you want to find in the "Find in reference" text box.
4. Start the search with the "Find next" button. If a reference is found, it is highlighted in the 

"Reference" column.
5. Enter the name or part of the name you want to replace for the found name in the "Replace 

with" text box. 
6. Click the "Replace" button to replace the currently selected tag. The "Replace all" button 

replaces all references found.

PLC user data types with "Struct" PLC data type
HMI tags support the use of the "Struct" PLC data type in PLC user data types or in arrays of PLC 
user data types. This means that PLC system data types, such as IEC_*, ErrorStruct, CREF, NREF, 
are also supported.
The "Struct" PLC data type cannot be used in Unified faceplates. 

Unified Engineering
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Unified faceplates
The following improvements have been made:
• Unified faceplates support the interface property "Authorization". Assign function rights to 

the interface property . With these function rights you restrict the operator control of screen 
objects of a faceplate instance. 
If you specify the value "None" for the interface property on a faceplate instance, operator 
control is not restricted.
If an authorization has been configured in a faceplate type and no authorization is assigned 
to the associated faceplate instance, the relevant screen object is blocked for operator 
control. 

• OpenFaceplateInPopup: Only faceplate versions used in the HMI device are available in 
runtime. 
– Use the faceplate version in the HMI device in a container or in a script as a reference.

The reference is not resolved if you dynamically generate the name of the faceplate 
version to be opened as a popup with a script.

– If there is no faceplate version with the name, an empty container is opened.
• Delta download is possible in the case of changes to faceplate type tags of STRUCT data type 

when the associated PLC user data type has uncompiled changes.

Improved usability when programming scripts
In the script editor, the options for selecting faceplates, graphics, text lists, alarms and logs have 
been improved. You open the dialog for selecting objects with the <CTRL + J> key combination.

Swapping a graphic in runtime
You can swap the graphic shown in a graphic view with another project graphic using the 
following script.
export function Button_3_OnTapped(item, x, y, modifiers, trigger) {
Screem.Items("Grafik view_1").Graphic = 
HMIRuntime.Resources.Graphics("GraphicCollection.Engine5").Name
}
Where 
• Button_3: The object on which the script is configured.
• OnTapped: The event on which the script is configured.
• "Grafik view_1": The name of the graphic view in which the screen is swapped.
• Engine5: The name of the graphic to be displayed.

System function "GetSpecialFolder"
Returns the path of a folder. The system function is executed independently of the operating 
system (Windows or Linux).

Unified Engineering
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Example:
HMIRuntime.fileSystem.GetSpecialFolder(HMIRuntime.FileSystem.enums.F
olderId.Tempdir)); 
The system function "GetSpecialFolder" has the following parameters:

Parameters Type Description
FolderID Enum Placeholder that returns the requested folder:

• Temporary folder: HMIRuntime.FileSystem.Enums.Folder‐
Id.TempDir

• Home directory of the user: HMIRuntime.FileSys‐
tem.Enums.FolderId.HomeDir 

The following paths are typical:

Type Path in Windows Path in Linux
Temporary folder C:/WINDOWS/ServiceProfiles/WCCILScs‐

Service /AppData/Local/Temp/
/var/tmp/

Home directory of the user C:/WINDOWS/ServiceProfiles/WCCILScs‐
Service/

/home/industrial/

New method "GetClientInfo" on the UI object
With this method you can query the dimensions of the screen with which you access a running 
WinCC Runtime Unified. Based on this information, you can display a start screen suitable for the 
client.
Member
Method of the "UI" object
Syntax
HMIRuntime.UI.GetClientInfo(HmiClientInfoType);
Parameters

Parameters Type Description
HmiClientInfoType Enum Returns the dimensions of the screen:

• PrimaryDisplayWidth: Width of the screen in device-inde‐
pendent units (DIUs)

• PrimaryDisplayHeight: Height of the screen in device-in‐
dependent units (DIUs) 

• PrimaryDisplayPixelRatio: Ratio of the number of pixels to 
DIUs 
Example 1.5: 1000 DIU = 1500 pixels

Example of use

Unified Engineering
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let displayWidth = UI.GetClientInfo(UI.Enums.HmiClientInfoType.PrimaryDisplayWidth);
let displayHeight = UI.GetClientInfo(UI.Enums.HmiClientInfoType.PrimaryDisplayHeight);
if (displayHeight > displayWidth)
{
  UI.RootWindow.Screen = "StartScreenPortrait";  
}
else
{
  UI.RootWindow.Screen = "StartScreenLandscape";  
}

Tag values in report names
Introduction
In the "Reports" control you configure, among other things, the report name of the reports 
generated by a report job. The name consists of a combination of the following placeholders: 
• Placeholders with user-defined fixed texts 
• Placeholders that are dynamically evaluated during the generation.

The following dynamic placeholder types are available:
– Counter operations 
– Date
– V17 Update 1 or higher: Process value of an online tag 

As of V17 Update 1, new operator controls support you in configuring the report name.

Requirements
• Installed software: WinCC Unified Engineering V17 Update 1 and WinCC Unified Runtime 

V17 Update 1
• The "Reports" control contains a screen of the runtime project that is running.
• To use the new operator controls to configure the placeholders in the control, reload the 

project in runtime after installing the update (load changes).

Procedure
To integrate a tag value in the report name, follow these steps:
1. In the "Reports" control, select "Report jobs" tab.
2. Select a report job in the work area.

You can see the settings for the report job in the detail area.
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3. Next to "Report name", click "Configure".
You see the following operator controls:

① To select the placeholder type
② To add the new placeholder
③ Table for the exact configuration of the added placeholders or for removing a placeholder 

Note
For the default report name "Report_<Counter>", "Report name" has the 
value Report_{NNN}. The table shows two placeholders:
• Report_: Fixed text
• NNN: Dynamic placeholder for a counter

Note
Change order
To change the order of the placeholders, delete the existing placeholders and add them again 
in the desired order.
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4. Select the "Tag" value under "Select placeholder type".
An empty tag placeholder is added at the end of the table.

5. Select online tag:
– Click the "..." button on the placeholder
– In the "Tag selection" dialog, click "Fetch".

You can see all the tags of the runtime project that is running:

Note
Scrolling and filtering
Use the page navigation buttons to scroll forward or backward.
To filter the displayed tags, enter a filter string in "Filter" and click "Fetch".
You use the wildcard "*" to filter by partial strings.
For example:
• *T* returns all tags with a "T" in their name.
• *T returns all tags that end in "T".
• T* returns all tags that start with "T".
When filtering for structures, the separators must be part of the filter string.

– Click the desired tag.
– Confirm with "OK".
Alternatively, enter the full tag name manually in "Value". 
For example: Brewery_PC1_RT1::MyTag1

 In the "Report name" field, the tag placeholder is added to the end of the report name. 

Result
• When generating the report in runtime, the process value of the tag is read out and 

integrated into the report name.
• If the process value contains a character that is not permitted in file names, it is replaced by 

an underscore.
• If there is an error resolving the name, for example, because the tag is not found in runtime, 

the tag placeholder in the name is replaced by the error name. The process is logged in the 
generation status of the report.
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Alternative procedure
Enter the desired combination of fixed texts and dynamic placeholders manually in "Report 
name". 
To integrate a process value, use the following placeholder: {@<Full_TagName>}
Example: Report_{yyyymmdd}_{HHMMss}_{@Brewery_PC1_RT1::MyTag1}

Restrictions
• A report name can contain only one counter.
• Make sure that the generated report name does not violate the policy of the operating system 

regarding the maximum length of file names.

Operator control of text and graphic lists on a touch screen
If a text list or a graphic list is configured on a symbolic IO field, you can scroll through the entries 
in the list with touch gestures on a touch screen in runtime.
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Unified PC 4
4.1 Important notes

This page contains important information about product properties.

Simulation of external tags in tag simulator
External tags can only be simulated with the WinCC Unified Tag Simulator if the project running 
in runtime is connected to the corresponding controller.

WARNING
Effect on connected controllers
Note that the simulated process values are written to the automation system. This can cause a 
reaction of the connected process I/O.

Loading the logon page
If you experience display problems in the Web client after you install the update, completely 
delete the browser data (history, form entries, etc.).  

Alarm view
An alarm cannot be displayed as multiple line text in the alarm view.

Using a Web server certificate created with the Certificate Manager
If you use a Web server certificate created with Certificate Manager on the Runtime server, re-
install the certificate after you install the update.

Using the Excel add-in after changing the computer name
If you change the computer name of a computer after the Excel add-in has been installed, you 
must run WinCC Unified Configuration and integrate the manifest again as web add-in in Excel.

OPC UA connection after operating system update or upgrade 
Updating or upgrading the operating system of the Unified PC, e.g. from Windows Server 2016 
to Windows Server 2019, may change the firewall settings. As a result, the OPC UA ports may be 
blocked. 
In this happens, start the Siemens "Security Controller" tool and run "Restore settings".
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4.2 Improvements in Update 5
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based, among other things, on the feedback 
received.

Screens and screen objects
Symbolic I/O field
• The behavior of the symbolic IO field when changing the associated tags has been improved.
System diagnostics control
• The buttons of the toolbar remain operable even if the style is changed in Runtime via a 

Javascript function.
Graphics
The display of graphics has been improved. 
Trend control
• In Runtime, when certain time filters were applied in the Trend control, the display 

disappeared and did not return until the next data record was loaded. The display now 
persists when any time filter is used.

System diagnostics control
• The stability of the system diagnostics control has been improved. 
IO field, symbolic IO field
In Runtime, the logon dialog is displayed correctly after enabling "Automatic login" in Runtime 
Manager. 
Parameter set control
• It was possible via scripts to visually activate disabled buttons in Runtime even if no 

parameter set had been selected. Buttons can now be activated only when a parameter set 
is selected.

Log off in Firefox
Logoff works correctly in Firefox. The user is logged off from all tabs/sessions. 

Operating system with date and/or time in the past
If a date and/or time from the past was set in the operating system settings, this caused problems 
in Runtime, except for the change from daylight saving time to standard time. 
Runtime now runs stable even if the date and/or time set in the operating system is in the past.
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4.3 Improvements in Update 4
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based, among other things, on the feedback 
received.

Text in the license box of the Asia dongle
The text of the alarm that indicates a missing dongle for an Asian language has been improved.

Screen keyboard
The behavior of the screen keyboard has been improved.

Shadowy objects
The shadowy objects that occur in conjunction with the "Show connection quality" property 
have been corrected.

Zooming in/out of screens
Zooming a screen with a touch gesture does not affect an open popup window.

Screens and screen objects
Bar
• The appearance of the bar has been improved in connection with the change of styles used 

in the "Runtime settings".
Screen window:
• The "Visibility" property of the graphic display is evaluated correctly even if the graphic 

display is used in a screen window.
• The display of the corners of a rectangle has been improved.
Browser
• The display of the Browser screen object has been improved so that even a deactivated 

function bar is displayed correctly.
• The "Browser" screen object shows the correct PDF page in runtime.
I/O field:
• The evaluation of the configured output formats has been improved for the I/O field.
• For the I/O field, the configured values for the "Spacing" property are displayed correctly in 

runtime, even if the object was originally created with WinCC V16. 
• The "Date and time" output format is displayed correctly.
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Trend control
• The trend control displays the legend correctly even after changing the data source of a trend 

in runtime. 
• The data source of a trend control can be changed even after a comment on an alarm has 

been added to an alarm view.
• If the visibility of a trend area is dynamized with a tag, the trend is displayed correctly in the 

trend control after switching from "False" to "True".
Alarm view:
• In the alarm view, the texts in the dialogs, such as the ones for filtering or sorting, are always 

displayed in the current runtime language.
• Scrolling in the alarm list has been improved.
Parameter set control
• The text in the information bar can be linked to a tag via the "Text" property and can be 

processed in a JScript, for example.
Slider:
• The slider displays the process value indicator - mode correctly.
Symbolic I/O field
• The display of the symbolic I/O has been improved regarding the use of transparent 

backgrounds.
• The display of graphics in the symbolic I/O field has been improved. 
Process control
• The "Delete archive value" button can be operated in runtime.
Text box
• If the "No." characters are configured in a text box, these characters are output correctly in 

runtime.
• When using the dark style, the text box is grayed out when the operator authorization is 

disabled.
• The display of centered text has been improved.

Faceplates
Text lists in faceplates are displayed correctly.
Graphics in I/O symbolic fields are displayed correctly.
A faceplate that is open as a popup is displayed in the specified position, even if the size of the 
faceplate container has been automatically adjusted to the screen size in the meantime.
If a faceplate has been opened in a popup and scripts are being executed, all scripts are stopped 
when you close the popup.
The display of transparent areas in a pop-up window has been improved.
When using the "WriteWithOperatorMessage" method in a faceplate, the tag name is displayed 
correctly in the alarm view.
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Alarms and alarm view
In system alarms, the display of referenced parameters has been improved.

Scripting
If the "Border - Color" property for an I/O field is changed via JScript, transparency is also displayed 
correctly.
If a pop-up window is opened dynamically in runtime and the "parentScreenPath" parameter is 
set, switching the display language is also possible at this time.
The Javascript instruction constructor.name is supported when the debugger for screen objects 
is disabled. This allows you to query the type of a screen object, for example:
let hmiType = Screen.Items('Circle_1').constructor.name // Result: 
HmiCircle
Even if an HMI device has been configured in a folder, the configured screens can be accessed via 
system functions, for example, when using the "ChangeScreen" system function.
Calling the GetPropertyValue system function returns the correct values for buttons in the 
toolbar of a configured parameter set control.
Debugging scripts is again possible without restriction.

"OpenFaceplateInPopup" function for Unified Comfort Panels
If a popup is called on a Unified Comfort Panel within a faceplate, it is displayed independently 
of the faceplate.

Reports 
When generating reports in runtime mode "Simulation", tags with Date and Time data type are 
output correctly in the report.
Error in the generation of PDF reports with newer MS Excel versions has been fixed.
The elements of structure tags are now output in reports sorted by the index number of the 
elements.
Data source items for PLC tags that have the "Cyclic in operation" acquisition mode now read the 
tag value directly from the PLC.
The installation of the Excel add-in on computers whose Excel uses the CH-ZN type language 
pack is now successful.

Certificate Manager
Removing devices from the Certificate Manager works correctly even if devices were logged on 
with only the IP address.
You can now renew the entire certificate configuration in the Certificate Manager. The certificate 
configuration also includes the application certificates of the devices.
To do this, select "Recreate all" in the shortcut menu on the root certificate.
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VoT: Display of website
The display of the website could no longer be displayed under certain circumstances with V17 
Update 2. The cause of this error has been fixed.
The indirect addressing of the tags works correctly.
Access protection to the custom web page has been improved.

Custom web controls
Custom web controls that were no longer displayed with V17 Update 2 can be used again.
If a start value and a tag are assigned to an I/O field, the custom web control applies the value 
of the assigned tags after updating the screen.

4.4 Improvements in Update 3

Contents
This update does not contain any improvements or changes relevant to WinCC Unified Runtime.

4.5 Improvements in Update 2
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

4.6 Improvements in Update 1
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.
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Changing the computer name or the IP address 
If the computer name or the IP address of a WinCC Unified HMI device changes, e.g. when adding 
the computer to a domain, follow these steps:
1. After changing the computer name or IP address on the HMI device, run WinCC Unified 

Configuration.
WinCC Unified Configuration automatically adjusts the computer name or IP address.

2. On the computer that serves as the certification authority, use WinCC Unified Certificate 
Manager to renew the certificate configuration of the HMI device.

3. If the HMI device participates in Unified Collaboration, adapt the configuration of the other 
devices in engineering system and download the changes to the devices.

4. If you use central user management and change the computer name of a Unified PC, you have 
to enter the new computer name on the UMC-S ring server manually in the whitelist. 
You can find additional information in the SIOS Portal, in the application example with the ID 
109780337 (https://support.industry.siemens.com/cs/document/109780337/central-user-
management-with-user-management-component-(umc)-?dti=0&lc=en-DE).

The projects loaded onto the HMI device using a user configuration loaded by TIA Portal are 
subsequently executable without reloading. 

Note
Adapt the configuration of the HMI device in engineering system before reloading the HMI 
device.

Adapting the runtime configuration

Note
If the computer name is used to access the website for the web clients, no adaptation of the 
runtime configuration in WinCC Unified Configuration is necessary after changing the IP address, 
and vice versa.

1. Start WinCC Unified Configuration.
2. To only include changes to the computer name or the IP address in the configuration, follow 

these steps:
– In the "Website settings" step, select the option "Only adapt to new computer name or IP 

address".
– Click "Next".
– In the "Apply Settings" step, click "Accept".

3. To change other settings, follow these steps:
– In the "Website settings" step, select the "Perform additional configuration" option.
– Click "Next" and make the required settings in the following steps.
– In the "Apply settings" step, click "Accept".
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Adapting device certificates
1. Start WinCC Unified Certificate Manager on the computer that serves as the certification 

authority.
2. Delete the HMI device whose host name or IP address has been changed from the Certificate 

Manager.
3. Add the HMI device again and enter the new computer name or the new IP address.
4. Generate the required certificates for the device.
5. Distribute and install the certificates.

Note
If the computer name or IP address of the certification authority has changed, you have to 
recreate, distribute and install the root certificate and the certificates of all Unified devices.

Automatic login for local Web clients
A local Web client is a Web client located on the same HMI device as WinCC Unified Runtime. 
Automatic login can be enabled for the local Web client of a Unified PC. 
Follow the steps below:
1. On the Unified PC, open the SIMATIC Runtime Manager as administrator.
2. Click the button  in the toolbar.
3. Select the "General" tab.
4. Under "Automatic login", enable the "Activate automatic login" option.
5. Enter the user name and password of the UMC user that is to use automatic login if no UMC 

user is logged in in runtime via UMC Desktop Single Sign-on yet when the local Web client is 
started or on login to runtime.

6. Confirm your entries with "OK".
7. Restart runtime.  
Result:
• On the start of a local Web client or on connection to runtime, the Web client automatically 

authenticates itself with the following user data: 

A UMC user is already logged in on the HMI device via UMC Desktop Single Sign-on (DSSO)
Yes The logged-in user is used.
No The user configured in SIMATIC Runtime Manager is used.

If no user has been configured in SIMATIC Runtime Manager, a hard-coded de‐
fault user without function rights is used.

All local Web clients use the same logged-in user. 
• Operators see the start screen of the project running in runtime. 
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• If the logged-in user does not have the authorization to operate a screen element, a login 
dialog opens. 
To operate the screen element, the operator must log in with a user with corresponding 
function rights. The open process screens remain open. 

• After logout of the user used for automatic login, e.g. via the "LogOff" system function, or 
after switchover to another user, automatic login is only possible again after runtime is 
restarted.
Logout takes effect in all applications that use DSSO. The local Web client switches to the 
hard-coded default user without function rights. The open process screens remain open. 

4.7 Improvements in the option update
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.
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Unified Panel 5
5.1 Important Information (Unified Comfort Panels)

Information that could not be included in the documentation and important information about 
product characteristics.

Configuring connections
For the Unified Comfort Panel in the engineering system, only configure control connections 
that are also available and used in plant operation.

Runtime and web client
Functional differences
Due to different technologies, temporary functional differences may occur between the 
operation of a Unified Comfort Panel runtime and a web client.
For example, not all buttons can be operated when operating the trend control directly on the 
Panel runtime. The web client has the same behavior as the Unified PC runtime. For this reason, 
the "Print" button, for example, can also be operated in the trend control.
Option to change user
If you use runtime locally on the Unified Comfort Panel, you will be shown an option to switch 
the user if you do not have sufficient function rights. This option does not apply to access via a 
web client. The following applies here depending on the HMI device image version used:
• HMI device image versions V17.0.0.0 and V17.0.0.1: A note about insufficient authorizations 

is displayed in the web client.
• HMI device image version 17.0.0.2 or higher: Operating objects without access 

authorization are shown grayed out.
To receive access to these operating objects, the user needs to log off and log on again as another 
user with the necessary access authorization.

Generic logon error due to browser language settings
If a language that is not supported by Unified Runtime is set as the browser language, the 
"Generic error" occurs during logon.
Proceed as follows:
1. Open the browser language settings.
2. Select one of the languages supported by Unified Runtime.
3. Log on in runtime.
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Browser download directory
On a Unified Comfort Panel, the browser download directory is: "/home/industrial/download"

Using the central user management
The following sections contain important information on parameters of the "TIA User 
Management Component (UMC)".
Auto logoff time
The UMC parameter "Account Policy > Auto logoff time (minutes)" is not supported by Unified 
Comfort Panels. A user logged on to the Unified Comfort Panel must log off manually.
Must change Password
The UMC parameter "Status > Must change Password" is not supported by Unified Comfort 
Panels. Make sure that this option is disabled for all users of a Unified Comfort Panel.
Password duration (days)
An expired password cannot be changed on a Unified Comfort Panel. To log on a user whose 
password has expired, change the password directly in the "TIA User Management Component".

Unified Collaboration
Note the following information when accessing a Unified PC from a Unified Comfort Panel via 
Unified Collaboration.
• Alarms on the Unified PC might be displayed on the Unified Comfort Panel with a delay.
• In the configuration of the Unified Comfort Panel, the Unified PC must be selected in the list 

"Connect actively to" under "Runtime settings > Remote Access > Collaboration".
In the configuration of the Unified PC, the Unified Comfort Panel must be selected in the list 
"Connect actively to" under "Runtime settings > Collaboration". 
Note: If the Unified Collaboration devices belong to different TIA projects, a bidirectional 
export/import of the screen references for Unified Collaboration is required to be able to 
execute the above operations.

Note the following information when accessing a Unified Comfort Panel from a Unified PC via 
Unified Collaboration.
• To access the screens of the Unified Comfort Panel, execute a screen change on the Unified 

PC after the first project download.
Note the following information when accessing another Unified Comfort Panel from a Unified 
Comfort Panel via Unified Collaboration.
• In the configuration of both Unified Comfort Panels, Unified Collaboration must be selected 

in the list "Connect actively to" under "Runtime settings > Remote Access > Collaboration".
Note: If the Unified Collaboration devices belong to different TIA projects, a bidirectional 
export/import of the screen references for Unified Collaboration is required to be able to 
execute the above operation.
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Password guidelines for SmartServer
The passwords of "User 1" and "User 2" for accessing the SmartServer must be different, consist 
of exactly 8 characters and contain the following characters:
• At least one uppercase letter (A ‑ Z)
• At least one lowercase letter (a ‑ z)
• At least one number (0 - 9)
• At least one special character (! $ % & ( ) * + , - . / : ; < = > ? @ [ \ ] _ { | } ~ ^) 

Display of I/O fields
As of HMI device image version 17.0.0.2, the following applies for I/O fields: It is not possible to 
enter a value outside the configured value range.
An I/O field is displayed with a red background for approx. two seconds depending on the data 
type of the assigned tag in the following cases:
• Integer and real tags: The entered value is outside the configured value range.
• String tag: The entered value exceeds the configured length of the string.
After entering a value outside the configured value range, the I/O field displays the last valid 
value.

Alarm view
Flashing on range violation
Flashing on range violation is not supported for the alarm view.

Scroll bars
Scroll bars are not available in the alarm view. Use the touchscreen to move the contents of the 
alarm view horizontally or vertically.

"Show recent" button
The "Show recent" function is only supported in conjunction with ascending sort order.

Moving columns
Moving columns within the alarm view is not supported.

Status bar
If a text was configured for the first element in the status line and an image for the second 
element, the image may not be displayed immediately after loading. In this case, perform a 
screen change.

Filter alarms
Multiple selection of filter criteria is not supported in the filter dialog of the alarm view.

Dynamize visibility of columns
The dynamization of the visibility of columns via a script or a system function is not supported.
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5.2 Improvements in V17 Upd. 5 (Unified Comfort Panels)
This update contains the HMI device image version 17.0.0.5. To make use of the corresponding 
engineering and runtime improvements, we recommend using WinCC Unified V17 Update 5 for 
configuring the HMI devices.

Communication with controllers
In addition to the controllers previously supported via TIA-integrated CSPs, you can connect 
Modbus RTU controllers to the HMI device via the RS422/485 interface and the corresponding 
communication driver.

Output of string variables in reports generated with LibreOffice 
When generating reports with LibreOffice, the output of single-value segments that contain 
string variables has been improved.

5.3 Improvements in V17 Upd. 4 (Unified Comfort Panels)
This update contains the HMI device image version 17.0.0.4. To make use of the corresponding 
engineering and runtime improvements, we recommend using WinCC Unified V17 Update 4 for 
configuring the HMI devices.

Event logger
In the Control Panel, the new function "Event Logger" is available under "System Properties". This 
function allows for logging complete Runtime operating scenarios on a storage medium.
Technical Support can use the logged data, for example, to analyze the cause of errors. You can 
find more information in the Control Panel help and in the operating instructions (https://
support.industry.siemens.com/cs/ww/en/view/109795870).

Network drive
In the Control Panel, the new function "Network drive" is available under "Network and Internet". 
You can use this function to exchange data between the HMI device and an enabled network 
drive on a server PC.

Note
Number of network drives
The maximum number of network drives with HMI device image version 17.0.0.4 is 1.

You can find more information in the Control Panel help and in the operating instructions 
(https://support.industry.siemens.com/cs/ww/en/view/109795870).
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Trace forwarder
The "Enable Trace logger" option can now be enabled independently of the 
"Enable Trace forwarder" option.

"OpenFaceplateInPopup" function for Unified Comfort Panels
If a faceplate popup is called up on a Unified Comfort Panel within a faceplate, it is displayed 
independently of the faceplate.

"LogOff" system function
An operating element with the "LogOff" system function may be access-protected via the 
"Authorization" property.

Scripting
Changing the size of a popup.
The size of a popup can be changed via a script.

Data source of trend view and f(x) trend view.
You can change the "Data source" property of a trend view or f(x) trend view via scripts in 
Runtime.

Stability of the VCS module
The stability of the VCS (Visual Core Service) module, which triggers the "Manager 
(VisualCoreService) not connected" and "RAM low" messages in certain cases in connection with 
an "Alarm Subscription" has been improved.

5.4 Improvements in V17 Upd. 2 (Unified Comfort Panels)
This update contains the HMI device image version 17.0.0.2. To make use of the corresponding 
engineering and runtime improvements, we recommend using WinCC Unified V17 Update 2 for 
configuring the HMI devices.

User administration
Number of logon attempts
The number of attempts to correctly input the logon credentials has been increased to 19. If the 
logon credentials are entered incorrectly again, the user involved is locked out. The user must be 
deleted and recreated, or you must reload the User Management into the HMI device.
System tag "@UserName"
The behavior of the system tag "@UserName" has been improved in HMI device image V17.0.0.2 
as compared to HMI device image V17.0.0.1. When a user logs off, the system tag "@UserName" 
is reset correctly again.
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SIMATIC Edge
As of HMI device image version 17.0.0.2, Unified Comfort Panels can use the "Standalone" or 
"Backend Managed" Industrial Edge management.
When "Apps" > "SIMATIC Edge" > "Open edge management" is clicked on for the first time, the 
"Activate Edge Device" dialog with the two possible options is displayed.
You can find detailed information in the Operating Manual "SIMATIC HMI Unified Comfort Panels 
Industrial Edge Device - Operation (https://support.industry.siemens.com/cs/ww/en/view/
109804671)".

Note
Select a user name without uppercase letters
The "SIMATIC Edge" login is only possible for user names without capital letters.

Trace logger
In the Control Panel, the new option "Enable Trace logger" is available under "Service and 
Commissioning" > "Trace forwarder". With this option, you can save "tracing" information on an 
external storage medium. Additional information can be found on the Internet (https://
www.siemens.com/ucp-cp-v17-help).

Supported printers
The following "Brother" printers were added on the local website "CUPS":
• BrGenML1
• HL4150CDN
• HLL2360D
• HLL5100DN
• HLL5200DW
• QL650 TD
• QL700
Open the local website "CUPS" via "Apps" > "Printer configuration" > "Printers".

Web Browser app
As of HMI device image version 17.0.0.2, the pre-installed app "Web Browser" is based on Firefox.
Some pages that use self-signed certificates may need to be classified as trusted in the 
certificate management of the web browser to avoid error messages.
Use the start script "runFirefox.sh" to start the "Web Browser" app from the project. 
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Control Panel help
In the title bar, you will find the "Help" button to the left of the "Login" button.

Use the "Help" button to open the "Unified Comfort Panels Help" dialog.
In the "Unified Comfort Panels Help" dialog, you have the following options to open the Control 
Panel help:
• Scan the QR code or enter the link under the QR code in the browser of an external device with 

Internet connection.
The help will be opened on the external device. You can read the help on the external device 
and navigate in the Control Panel of the HMI device at the same time.

• If your HMI device has an Internet connection, click the link under the QR code.
The help will open on the HMI device.

5.5 Improvements in V17 Upd. 1 (Unified Comfort Panels)
This update contains the HMI device image version 17.0.0.1 for projects that were configured 
with WinCC Unified V17 Update 1.

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

Audit for Unified Comfort Panel
Unified Comfort Panels support the Audit option as of Update 1.
When creating the project, make sure that verifiable operator actions can only be performed by 
authorized personnel, e.g. by configuring buttons with an "Allow operator control" operator 
authorization. If a user can perform a verifiable operating action without first logging on to the 
device, this may result in an insufficient verification requirement.

Trend control
You can also use a trend control to configure the "Min Max" compression mode for Unified 
Comfort Panel.
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